Guide to the NATFHE local web editor





Introduction


The NATFHE local web editor enables non-geeks and technophobes to create attractive local web pages with the minimum of web knowledge. The web editor does this by automatically creating all the design elements of the website such as the website header and the links to the different sections. All you need do is write the text that goes on each of the pages.





The picture below shows the basic look your site will have.





�





The website has 5 main pages with the following titles:


Home Page 


Information


Advice


News and Events


Links 





Within the Information page there are 4 further pages for the following subject matter:


Branch Officers


Pay and Conditions


Health and Safety


Equal Opportunities





This gives you a maximum of 9 pages for your site. You do not have to use all of these pages if you do not wish to. For example, if you leave the Advice page blank then the link to it at the top of the page will not appear and your site will not have an advice section.





Getting Started


You access the NATFHE local website editor via your web browser by typing:


www.natfhebranches.org.uk/admin.





You will now see the NATFHE local website editor logon page. You will need to enter your branch code and password. 





Having done that you will see the first page of the Web Editor, entitled “Edit main pages”. On this page you will see 5 boxes, each one labelled with the name of one of the 5 main pages i.e. “Home Page”, “Information”, “Advice”, “News and Events”, “Links to Other Sites”. If you type or paste some text into one of these boxes then click on the “Update branch website” button at the bottom of the page, this text will appear on the relevant page on your site.





Having clicked on the “Update branch website” button the next screen you will see should tell you that your web site was edited successfully. It then offers you 3 options:�Check your branch web site�Re-edit your branch web site�LOG OUT





Click on the “Check your branch web site” option and the editor will open another browser window displaying the home page of your site. Now you should see the text you have entered into the boxes on the editor on your web pages. It may not look quite how you anticipated, but this is because you need to learn a little about formatting the text. This will be covered later in this guide.





If you are not happy with the way the web pages look then return to the first browser window which is still displaying the Web Editor and click on the “Re-edit your branch web site” option to return to the “edit main pages” screen. Make the desired changes and click the “Update branch website” button one again.





If you have not closed down the browser displaying your website then you will not have to click on the “Check your branch web site” option again. However, to see the changes you have made you will have to click on the “Refresh” button on the toolbar or select it from the “View” menu.





Once you are happy with what you see, return to the Web Editor and click on the LOG OUT option and close the browser.


Entering your web page text


As you can see, the boxes in which you type the page text on the “main page editor” are very small, so it will probably be easier to type out the text in a text editor (i.e. WordPad, Notepad) etc.





Do not use Word!


Do not use Word or, similar sophisticated word processor, to create the text – Word automatically does a lot of complicated formatting which will appear as errors in your web page. For example, an apostrophe typed in Word appears on the web page as - &#8217. Use WordPad, Notepad or some other such simple text editor and save it as a .txt file (i.e. text only, no formatting). The exception to this is if you have Word 97 from the Office97 Suite – this version of Word can create formatted documents for web pages with clear and simple tags, ready to go on your site. Notes on how to do this will be available shortly. I do not have any information on how other non-Microsoft word processors deal with creating web pages. If you have any knowledge of this you can email me on bfotherby@natfhe.org.uk. 





If you already have a Word document


If the text you wish to put on the web page is already saved as a Word document then you can still use it by changing it to a “text only” file.


Open the Word document and select “Save As” from the File menu.


Select the “Text Only (*.txt)” option from the “Save as type:” dropdown menu at the bottom of the box.


You will then get a warning come up saying: �”(name of your file) may contain features that are not compatible with Text Only format. Do you want to save the document in this format?”�Just click the Yes button. What it means is that any formatting such as bold, italics, headings, paragraph spaces etc will be lost. This is exactly what you want to happen.


Having done this, you can now open your .txt file in WordPad and format it for the web page using tags as described below.


Formatting the text


Although you can do some formatting in WordPad such as bold and italic, this formatting will be lost when you paste the text into the Web Editor, or when you save it as a .txt file.





Tags


For web pages you need to tell the browser how to format (display) the web page using “tags”. A tag is just an instruction inserted into the body of the text inside a pair of greater than “<” and less than “>” signs. If you look open a web page in a simple text editor such as WordPad you will see all the tags embedded in the text of the web page, but when you look at the page through your browser e.g. Internet Explorer, anything inside <> tags does not appear.





End Tags:


As well as telling the browser where to start a format change with a tag, you have to tell the browser where to return to the standard format with an end tag. End tags use a forward slash “/” to indicate they are end tags. e.g. The instruction to tell the browser to display text as bold is <B>. To stop display in bold, the end tag is </B>.





So to display the following text on your web page:





I know how to be bold on a web page.





your text in WordPad etc, or the web editor would look like this:





I know <B>how to be bold</B> on a web page.


The Paragraph Tag -  <P>


The paragraph tag is indispensable. If you learn only this one you will be able to create very simple pages using the web editor. Pressing the enter key in the text or web editor will not automatically create a new paragraph on the web page. You need to use paragraph tags to create separate paragraphs. A paragraph tag will automatically create a line space between paragraphs. 





End Tag: </P>


Although in most cases it will work without the end tag, it is good practice to use one, and is a good habit to acquire, as most tags need them.





Example:


To create the two paragraphs of text below:





NATFHE is the largest trade union and professional association for lecturers, trainers, researchers and managers working in further and higher education throughout England, Wales and Northern Ireland. You can find out more about NATFHE from the national NATFHE website which you can access from the links page.





The Secretary and Chair of our branch are available in room H108 every Thursday between 12.30 pm and 2.00 pm (extension 1269). Members and non-members are welcome to drop in to discuss any issues.





add a start and end paragraph tag in the web editor or text editor as shown below.





<P>NATFHE is the largest trade union and professional association for lecturers, trainers, researchers and managers working in further and higher education throughout England, Wales and Northern Ireland. You can find out more about NATFHE from the national NATFHE website which you can access from the links page.</P>





<P>The Secretary and Chair of our branch are available in room H108 every Thursday between 12.30 pm and 2.00 pm (extension 1269). Members and non-members are welcome to drop in to discuss any issues.</P>


Very simple web pages


If you don’t wish to learn how to use the other formatting tags described below, you can still create web pages using just the <P> tag. Either in WordPad or directly into the boxes in the Web Editing page, simply add <P> at the beginning of each paragraph. Instead of using bold to make headings etc stand out you could simply use capitals. 





You would not be able to place links in the text of your web page, but you could add the link to the Links page very easily without having to use any tags (see the Adding links to the Links page section), and just refer to it in the page text as in the first paragraph in the example below.





Example


A simple web page might look like this: 





<P>WELCOME TO NATFHE AT ANYTOWN COLLEGE 


<P>NATFHE is the largest trade union and professional association for lecturers, trainers, researchers and managers working in further and higher education throughout England, Wales and Northern Ireland. You can find out more about NATFHE from the national NATFHE website which you can access from the links page.


<P>The Secretary and Chair of our branch are available in room H108 every Thursday between 12.30 pm and 2.00 pm (extension 1269). Members and non-members are welcome to drop in to discuss any issues.


<P>NATFHE information is posted on the notice board outside the copy shop in the A100 corridor. There will also be space for NATFHE information on the notice boards in each of the divisional offices and staff rooms.





The resulting web page will look like this:





�





The index listing


As well as the main text that you put on to each page, you can add an index listing of extra items. For example, on the 'News and Events' page you will have the main text that you enter in the form below, but you can also add extra news and events listings, which appear in a table below the main text. The website visitor can click on any of these items to find out further details. This allows you to add more content to the page without making it too long. 





�
Here is a picture of a web page containing an index listing:





�





Here is a close up of an indexed item:





�





Title


The first line of text is the title of the item, and is created by entering the text into the “Title” box beneath the “select page” menu.





Date Published


On the right hand side is the “published date” which is the value in the next box on your screen. Unless you type over it, it will put in that day’s date. If you type in a date that is after the current date, the item will not appear on the web page until that date. This is similar to an embargo date used on press releases.





Introduction


Underneath the title is a small line of text. This is the introduction and is created by entering text in the introduction box located below the publishing date box.





Detail


Beside the introduction is a link that says “more”. If you click on this you will see a new screen with an expanded version of just that item. The extra text below the introduction is called the detail. 


 


Expanded item


After you have looked at the expanded version of an index item you can click on the “next item” link below the index item and it will display the expanded version of the next index item in that table.


Adding a new indexed item


Underneath the explanatory text at the top of the “Edit main pages” screen you will see a link called “Add or edit an indexed item”. Click on this and you will see a screen with an option to “Add a new item” at the top of the page. Click on this link to access the screen that allows you to add an indexed item.





The first box you will see is a drop down menu from which you choose the page on which you wish to add the indexed item. As well as the 5 main pages, the 4 extra pages within the Information section (Branch Officers, Pay and Conditions, Health & Safety and Equal Opportunities) are also listed, and you can select any of these. They all work in the same way except for the Links page, which will be described in a separate section below.





Next there is a box called “Title” in which you enter the title of your index item.





The next box on your screen is “published date”. Unless you type over it, it will put in that day’s date and that will be the “published” date in the index listing. If you type in a date that is after the current date, the item will not appear on the web page until the date you entered. This is similar to an embargo date used on press releases.





You can then add any text you wish to appear in the introduction line and the detailed section by entering it in the relevant box. You can format it using tags as for your main pages. If you do not enter anything in the detail box the little "more” link will not appear and there will be no expanded version.





Now click the “Add item” button at the bottom of the page and then return to your website to check the changes you have made. Don’t forget that if you have your website already open you need to click on the “Refresh” button to see the changes.





Editing or deleting indexed items


From the “Edit main pages” screen, click on the “Add or edit an indexed item” link. At the bottom of the page that comes up you will see a table listing the title, page location and date published of all the index items that you have added to your website. To edit a particular item, click on the title of that item in the list. You will now see a screen with all the boxes that you used to add an index item. Make any alterations to the text in the relevant box then click on the “Edit item” button at the bottom of the page. Check the alterations on your site as usual.





To delete an item, follow the steps above, but click on the “Delete item” button at the bottom of the page.





Warning: There is no undo facility in the “Website Editor” so make absolutely sure that you have selected the correct item before clicking the Delete button.





Adding a link to the Links page


To add a link to the links page go to the “Add an indexed item” page, as described in the “Adding a new indexed item” section above. From the page location drop down menu at the top of the page select the “Links” option. In the “Title” box type in the name of the website you wish to put a link to, e.g. ”Equal Opportunities Commission”. If you want an introduction line to appear under e.g. “This site has useful information on equal opportunities legislation”, then type it into your text into the “Introduction” box, but you can just leave it blank. The essential part is to add the full web address to the “Detail” box as this will create the actual link.





It is best not to type in the web address as it easy to make errors, and then the link will not work. In your web browser and open the home page or other page of the site you wish to link to. Click in the “Address” box (i.e. the box where you type in the web address of the site you wish to visit) so that the whole of the web address is highlighted. Select “Copy” from the Edit menu. Now return to the Web Editor, click in the “Detail” box then select “Paste” from the Edit menu to paste the web address into the box. Now click the “Add item” button at the bottom of the page and your link will have been added to the Links page.





Note: You may find you have added a Link, but cannot access the Links page, as the link to the Links page does not appear at the top of the page. This is because there is no text in the box for the Links page on the “Edit main pages” screen of the Web Editor. Just add a line of text such as: “Here is a list of useful links” and click on the “Update branch website” button. Now when you go to your website (and click on the refresh button if necessary) you will see the link to the Links page and you will be able to view it and check that your link has been added. It is always a good idea to click on any link you add and make sure it is working properly.





More Tags


Here are the basic tags you can use to improve the look of your web pages and make the text easier to read.





Bold Text:


<B>


End Tag: </B>


You will soon know if you have forgotten the end tag as the rest of the page will all be in bold.





Example:


To create the following effect:





I most emphatically disagree with that suggestion.





use the bold tag as follows -





I <B>most emphatically</B> disagree with that suggestion.





Italic Text:


<I>


End Tag: </I>


Use in exactly the same way as the bold tag to create italicised text.





Bold and Italic Text:�Just use a the bold and italic tags in series, i.e. <B><I>, with corresponding end tags - </B></I>





Example:


To create the following effect:





I wish to differentiate this item from the rest of the blurb.





Use the <B> and <I> tags together as follows –





I wish to <B><I>differentiate this item</I></B> from the rest of the blurb.





Line Break:


Using a <P> tag will add a space between the two pieces of text. If you just wish to go to the next line within a paragraph you can use a line break tag.


<BR>


End Tag: The <BR> tag does not and must not have a end tag.





Example


To create the following paragraph:





The following people will be stewards during the picket outside the college on Thursday 30 May:


Anne Jones


Wes Finnegan


John Banks





Use line breaks as follows





<P>The following people will be stewards during the picket outside the college on Thursday 30 May:<BR>


Anne Jones<BR>


Wes Finnegan<BR>


John Banks</P>





Headings:


You can create a range of headings using the heading tags. Like the paragraph tags they create an automatic line space before the following paragraph. Heading tags are used in place of, not as well as, <P> tags. There are 6 heading tags - <H1> creates the largest heading and <H6> the smallest. The tags and are as follows.





<H1>H1 heading is bold and big</H1>


<H2>H2 heading is bold and not so big</H2>


<H3>H3 heading is bold and middle sized</H3>


<H4>H4 heading is bold and a bit smaller</H4>


<H5>H5 heading is bold and even smaller</H5>


<H6>H6 heading is not bold and the is the smallest</H6>





On the web page they will appear similar to the following:





H1 heading is bold and big





H2 heading is bold and not so big





H3 heading is bold and middle sized





H4 heading is bold and a bit smaller





H5 heading is bold and even smaller





H6 heading is not bold and the is the smallest





Links:


To create links within the text of a page you need to use an <A> tag and an end tag </A> to mark the end of the link. However, inside the beginning <A> tag you need to include the full address (URL) of the link. (Alternatively, you can add links without using tags on the “Links” page – see The Links Page section below.





Example


To create a link to the main NATFHE website on your page in the following paragraph (text that forms the link is in red)-





More information on pay and conditions is available from the main NATFHE website.





Your page in the web editor would look like this-





<P> More information on pay and conditions is available from the main �<A HREF=”http://www.natfhe.org.uk”>NATFHE website</A>.





Don’t worry it’s easier than it looks. The trick is never to type in the web address, instead paste it in from the address box on your browser. This avoids the possibility of making a mistake when typing in the web address, which will mean that the link does not work. It also means you automatically get the essential “http:// “ part of the web address. Thirdly, it means that you have will have checked that the website still exists at that address.





Here’s a step by step guide:





At the point in the text where you want your link to start type:�<A HREF=”


Go to your web browser and find the home page or other page of the site you wish to link to.


Click in the “Address” box (i.e. the box where you type in the web address of the site you wish to visit) so that the whole of the web address is highlighted. Select “Copy” from the Edit menu.


Return to the web or text editor and make sure the cursor is directly after the quote marks in your tag (i.e. A HREF=”) and select “Paste” from the Edit menu.


Complete the tag by typing:�”>


Now place your cursor where you wish the linked text to end and type the end tag:�</A>





Notes:	Make sure that there are no spaces inside the quote marks that contain the web address or the link will not work. Do not forget the end tag (</A>) or the link will not work. Make sure there is some text between your <A  HREF=”xxxx”> and </A> tags or there will be nothing for the user to click on.








Email link:


Email links are usually added to email addresses on a web page. When you click on them they open the “new message” box in the user’s email programme (eg Outlook) with the email address all ready in the To: section. The same <A> tag is used to create this, with different wording in the "HREF=” part of the tag. Having mastered the link tag, you will find this easy.





Example


To create an email link in the following paragraph-





You may email the branch secretary if you have any further queries.





The text in the text editor will look like this-





You may email the <A HREF=”mailto:bfotherby@natfhe.org.uk”> branch secretary</A> if you have any further queries.





Step-by-step guide


At the point in the text where you want your link to start type:�<A HREF=”mailto:


Then type in the email address. Remember, there must be no spaces within the quote marks.


Finish the tag by typing:�”>


Place your cursor where the email link is to finish and type the end tag:�</A>


